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Requested Enhancements 10/20/2018 - 05/23/2019

Date ImplementedItem Description

01. 10/30/2018 Commands - Is there a way to get the position of the mouse pointer on a right click, click, etc? 

Four addition properties were added to support the ability to recognize the mouse position by X,Y
coordinates, for the current window, or the entire screen.

  . MOUSE_FROM_SCREEN[X]
  . MOUSE_FROM_SCREEN[Y]
  . MOUSE_FROM_WINDOW[X]
  . MOUSE_FROM_WINDOW[Y]

Example:

    GETPROPERTY APPLICATION 'MOUSE_FROM_WINDOW[X]' 'vFormX'
    GETPROPERTY APPLICATION 'MOUSE_FROM_WINDOW[Y]' 'vFormY'

02. 11/20/2018 Utilities - The CHOOSE, PAUSE, and DIALOG command syntax builders (Utilities > Plugins) were
updated to produce color names instead of integer values.

03. 11/21/2018 Forms - I need an EEP when an item is dragged within the list of a Variable Lookup List View.  There is
a Drag and Drop EEP, but it is looking for an item to be dragged in and dropped from elsewhere than
the same list/control.

04. 12/03/2018 Forms - For the Enhanced DB Grid control, is it possible to provide an option to not display the
vertical scroll bar.

05. 12/03/2018 Forms - When enabling the "Show Footer" check box for an Enhanced DB Grid control, the "Footer
Height" value will automatically be set. The default value is 21 pixels, but will also be set according
based on the grid's font.
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06. 12/06/2018 Reports - Can the Items in the PDF Combo Box and PDF List Box report/label controls include the
functionality to be populated from a table lookup/SELECT command, to avoid having to manually
modify the list for every change.

A new "Data Query" option is available to specify a SELECT command to populate the control.

07. 12/07/2018 Forms -  It would be useful in drag-and drop operations if R:BASE would provide the Component ID
for the object being dragged, and the Component ID for where that dragged object is dropped.   
Two (GETPROPERTY only) properties have been implemented:

    . DraggedCompID - returns the Component ID of the dragged object, and is valid in the "On Start
Drag" EEP only

    . DroppedToCompID  - returns the Component ID for where a dragged object is dropped, and is
valid in the "On Drag Drop" EEP only

Examples:

    GETPROPERTY RBASE_FORM DraggedCompID vDragComponent
    GETPROPERTY RBASE_FORM DroppedToCompID vDroppedToComponent

08. 12/10/2018 Settings - When FEEDBACK is set ON it would be nice to be able to see which table is being used.

09. 12/13/2018 Functions - A new CHKTABLE function was added to see if a table/view exists. The function returns a
value based upon the permanent or temporary nature of a table or view, and if a table is attached as a
server or dBASE table.

    0 = table/view does not exist
    1 = permanent table
    2 = temporary table
    3 = server table
    4 = dBASE table
    5 = permanent view
    6 = temporary view

10. 12/14/2018 Help Files - I was reading the file Forms manual to understand all the capabilities of the Enhanced DB
Grid object. Unfortunately, there is too much to learn by trial and error, and there I items I still cannot
figure out. 

Additional details were provided for the Enhanced DB Grid "Footers" and "Bands", as well as Columns
and the "Predefined Values", "Expression", and "Pop-up Menu" tabs.

11. 12/14/2018 Utilities -  Added "search history" support for the Database Explorer, R> Prompt Output, Data
Dictionary search utilities. The entry box is now a drop down where the search history is available in
the drop down items. To clear the history, press the [Ctrl+R] key combination. The search history is
saved in the C:\Users\<User>\RBTI\ folder within the DBEXP.RST, DATADICT.RST, and RPROMPT.RST
files.

12. 12/20/2018 Data Dictionary - When using the Columns tab in the Data Dictionary, could it remember the last table
name that was selected? Very often I need to get column names from the same table multiple times
and each time I have to scroll down through the list to reach the table I had just used.
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13. 01/03/2019 General - For R:BASE, and all add-on products where a file history can be referenced, when right
clicking on the program within the Windows taskbar, the pop-up "Jump List" now provides details for
R:BASE-specific recent files launched. For R:BASE specifically, three sections are available for recent
databases that were connected, recent command files launched within the R:BASE Editor, and recent
External Form Files opened in the designer. 

The built-in Windows 7/10 functionality allows an item in the Jump List to be "pinned" for constant
references, until unpinned. In order for the Jump Lists to appear, Windows 10 computers must have
the setting enabled within the "Start" > "Show recently opened items in Jump Lists on Start or the
taskbar" section.

14. 01/11/2019 R:BASE Editor - New multi-view support in the R:BASE Editor with dual command files visible
simultaneously. To activate multi-view, right click a file tab and click "Move To Other View". A
command file tab can be moved between the two sections. Each section can be resized. Newly
opened files will be added to the active view/pane.

15. 01/11/2019 Data Designer - Please display the Data Designer warning if a new table is being created in multi-user
mode, just as it displays for modifying a table.

16. 01/14/2019 Report Wizard - When using the Form Wizard, there is a "Use Field Comment As Caption" check box
option. Can this same feature be added to the Report Wizard?

17. 01/14/2019 Functions - A new LASTMOD function has been implemented to provide the last structure
modification timestamp for a given table or view.

    SET VAR vLastMod DATETIME = (LASTMOD('InvoiceHeader'))

18. 01/22/2019 Database Explorer - Added "search history" support for the Custom EEP, Control Property, and
Expression searches within forms, reports, labels, external forms, and applications. The entry box is
now a drop down where the search history is available in the drop down items. To clear the history,
press the [Ctrl+R] key combination. The search history is saved in the C:\Users\<User>\RBTI\ folder
within *.RST files, based upon the search type and module.

19. 01/23/2019 Commands/Functions - Two new analytic functions, LAG and LEAD, have been implemented for
SELECT statements. 

LAG accesses data from a previous row in the same result set. LAG provides access to a row at a given
physical offset that comes before the current row. Use this analytic function in a SELECT statement to
compare values in the current row with values in a previous row.

LEAD accesses data from a next row in the same result set. LEAD provides access to a row at a given
physical offset that comes after the current row. Use this analytic function in a SELECT statement to
compare values in the current row with values in a next row.

    SELECT BillToCompany, TransDate,  NetAmount, +
      LAG(NetAmount,1,0) AS PrevAmount +
      OVER (PARTITION BY BillToCompany ORDER BY TransDate) +
      FROM InvoiceHeader WHERE BillToState = 'CA'

20. 01/23/2019 R:BASE Editor - With dual command files displayed simultaneously, synchronized scrolling has been
implemented to move up and down the panes mutually. Press the [Ctrl] key while scrolling the wheel
mouse to activate synchronized scrolling.

21. 01/25/2019 Commands - Added MDI parameter to the RBBEDIT command to launch the BLOB Editor in a
modeless window. The MDI option allows users to access other windows without closing the BLOB
Editor window first.

    RBBEDIT ScreenShot.jpg IMAGE MDI
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22. 01/29/2019 Settings/Help - The "Settings" > "Startup Options" is missing a Help button (though the Help page
itself does exist).

23. 01/29/2019 Watch Variables - In the Add/Remove Watch Variables panel, the "Show/Hide" button is displayed.
When the Watch Variable List is displayed, the "Show" button is listed, but the text "Show" and "Hide"
does not change to indicate the state of the toggle as Watch Variable Windows are selected, set to
shown, and set to hidden.

24. 01/31/2019 Forms - A new property was added to select/highlight a task item in the DB Task Tracker control.

Example: 

    PROPERTY DBTaskTracker1 SELECT_TASK .vTaskID

25. 01/31/2019 R> Prompt - If the Favorite Commands panel is open when R:BASE shuts down, it should (at least on
option) automatically reopen on the next start.

26. 02/04/2019 Data Browser - If the Data Browser is started from a BROWSE command for a non-editable
(multi-table) view, selecting Edit Mode from the Edit menu or pressing F4 is not prohibited, but
produces the message "The dataset is read-only". In this case, the Edit Mode menu option should be
grayed-out and pressing F4 should produce a clearer error message, such as "Cannot edit a
multi-table view".

27. 02/04/2019 Commands - When using the SELECT ... HTML 'title' command syntax, the generated HTML does not
place the <TITLE> portion in an expected <HEAD> section.

28. 02/04/2019 Data Browser - NOTE columns are displayed inconsistently, depending on whether the Data Browser
is in View as Grid or View as Row mode. In the former case, the NOTE value is displayed as expected,
but in the latter case, the NOTE value is displayed only as "(Memo)". It appears R:BASE should support
the display of the NOTE data.

29. 02/06/2019 Report Designer - Just as is currently done with Form Designer, if multiple controls are selected in
Report Designer, the Object Inspector should display all properties that are common to those controls
and allow the user to modify the entire group with a single edit.

30. 02/07/2019 Functions - The (DWRD(value)) conversion function converts the currency value into words. It would
be helpful to also provide an option to return fractional whole dollars for the cents portion ($10.50 =
Ten and 50/100).

31. 02/07/2019 Form Designer/Help Files - Some control sub-property editors lack a Help icon (though the actual
Help pages do exist). Examples include the Column Properties within the Enhanced DB Grid, Tab
Properties for the Enhanced Tab Control, and available Panes for the Status Bar.

32. 02/11/2019 Utilities - The Database Versions utility should support various filters to limit the search. Examples of
useful filters would be: filename (with wildcards), file extension, and date-range. Also, when the folder
to be scanned is the root directory of a partition, there should be an option to exclude databases
found in the Recycle Bin.

33. 02/15/2019 Forms/Commands - A new APPLICATION property was added to turn off "RBTI Variable" (RBTI_*)
processing in forms. If perhaps the variables are seldom used in an application, the processing may be
turned off, as the variables are assigned in almost everything performed within a form.

    PROPERTY APPLICATION CAPTURE_RBTI_FORM_VARS ON/OFF

This property is ON by default. To take advantage of this optimization, set it to OFF upon the
application startup. Then, turn it ON only in forms that use the RBTI_* variable values. Make sure the
property is turned OFF again when the form is closed.
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34. 02/15/2019 ODBC - The R:BASE ODBC drivers and engines have been further enhanced to be compatible with
MariaDB amd MySQL database connections.

35. 02/18/2019 Database Explorer - The tabs in the main R:BASE window should be draggable to alter their relative
positions.

36. 02/18/2019 Data Dictionary - The display of Variables should include the current character-count for each variable
of type NOTE, just as it does for variables of type TEXT.

37. 02/18/2019 R> Prompt - The Favorite Commands panel should support multiple command-lists, implemented,
perhaps, as multiple tabs. This would be useful, for example, when there is a distinct list of favorite
commands associated with each database. Another example would be dedicating a "temporary" tab
for experimentation with R:BASE command-variants without disturbing the "permanent" list of
favorites.

38. 02/18/2019 Settings - The statistics produced by Feedback should optionally be spooled to the Output Console
(or other current output destination) in addition to or instead of to the popup dialog box as at
present. When preserved in this manner, the Feedback statistics would provide a useful debugging
log of events, especially when interspersed within an ECHOed command trace.

39. 02/19/2019 R> Prompt - The Favorite Commands panel should provide a Run button in addition to the Select
button to optimize the common case of immediately running a favorite command without
modification. Double-clicking a command could also trigger its execution to the input console.

40. 02/19/2019 Data Browser - Can the status bar display the datatype character-count when NOTE columns are
highlighted?

41. 02/20/2019 Database Explorer - The dialogs that list forms/reports/labels from the main toolbar and drop-down
menu options now list the name, table, and comment  (Form â€“ Design/Run, Report â€“ Design/Print,
Label â€“ Design/Print).

42. 02/20/2019 Commands - The DIALOG command should support built-in options for positioning the message box
at the TOP and/or BOTTOM of the display.

43. 02/20/2019 Commands - It would be helpful to extend the PROPERTY APPLICATION FEEDBACK_POSITION_TOP
and PROPERTY APPLICATION FEEDBACK_POSITION_LEFT commands with variants for RIGHT,
BOTTOM, HORIZONTALCENTER and VERTICALCENTER. These latter two would eliminate the need for
the application to make calculations based on the series of values returned by GETPROPERTY
APPLICATION MONITOR_PROPERTY.

44. 02/20/2019 R> Prompt - In the Favorite Commands where multiple tabs/lists are defined, the right click popup
options â€œCopy Toâ€  and â€œMove Toâ€  are available for commands.

45. 02/20/2019 Form/Report/Label Designer - The listing produced by Document Custom EEPs should identify the
directory containing the database. One use for the listing is to compare the EEPs for
identically-named databases (e.g., production and test versions) in different directories, and it is
important to know which version the listing is documenting.

46. 02/21/2019 Form Designer - The Tab Order Settings should include a "move control to end" functionality/option,
such as entering any large number in the Tab Order input field should move the control to the end of
the list.

47. 02/22/2019 Form Designer - The text displayed by the Current Field Pane in a Status Bar control does not
distinguish between a DB Control and a Variable Control, using the terminology "Field" for both. It
would be more informative if "Variable" was used for variable controls.
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48. 02/22/2019 Form Designer - When clicking on an item found by Find in Form Control Properties while Form
Designer is displaying a matched form, the corresponding control should be highlighted within that
form.

49. 02/22/2019 Form Designer - On the Existing tab of the Object List toolbar, clicking on one or more controls
results in a gray highlight, which is exactly the same color as is used to identify locked controls
(although only the latter are bolded). It would be clearer if a different highlight color were used.

50. 02/22/2019 Commands/Forms - A new  AUTO_FORM_ALIAS PROPERTY command parameter was implemented.
When ON, forms without an alias are given an alias using the form's name.

    PROPERTY APPLICATION AUTO_FORM_ALIAS ON/OFF

51. 02/22/2019 R:BASE Editor - Compare by Content should display the file dates for the two files being compared.
This would make it clear which one is newer.

52. 02/22/2019 R:BASE Editor - Consider relocating the Compare by Content menu item to a more discoverable spot
in the menu hierarchy; its current position under View -> Toolbars is not very intuitive.

53. 02/22/2019 Commands - The log-output spooled by PROPERTY APPLICATION LOG_EXEC_EEP ON should be
prefixed with some distinctive string so that it can be easily spotted or found (with Ctrl-F) when
embedded among many other lines spooled to the Output Console. 

The prefix [EXEC EEP <DateTime>] is now added to the log output. 

54. 02/25/2019 R:Compiler for R:BASE - A new setting has been added to specify if compiled executables support
R:BASE form skinning (skins/themes). When unchecked, R:BASE forms are native. The advantage to
being a native form is the program does not have the possible quirks/encounters that can be
introduced when manual drawing forms, compared to the operating system drawing the forms and
controls. The default value is checked.

55. 02/25/2019 Form Designer - In a Variable Lookup List View with the Grid Lines attribute selected, the vertical grid
lines should extend into the header row.

56. 02/27/2019 Data Dictionary - When reviewing the "Key/Indexes" tab of the Data Dictionary it would be helpful to
expose the column names for key/index references.

57. 02/27/2019 Commands - The LIST FKEYS command display the results using an internally-generated ID number
(e.g., #53). As there doesn't appear to be a way of directly correlating that ID number with a column
name, it would be helpful to explicitly expose the column name to the LIST display.

58. 03/04/2019 Form Designer - The Tab Order Settings should number each listed control with its current tab-order
numeral so that the desired new position can be directly entered into the Tab Order input field
without losing the originally-highlighted item during a manual count.

59. 03/04/2019 Forms - A new "Recreate Columns After Refresh" property has been implemented to specify if the
columns are preserved after the control is refreshed. When checked, the columns are cleared then
recreated every time the list view contents are refreshed. When unchecked, the columns will be
populated only after the first load.

60. 03/05/2019 Form/Report Designer - With the designer open and viewing Form/Report Component IDs within the
Data Dictionary, as each row is highlighted, the corresponding control should be highlighted within
the form/report.

61. 03/08/2019 Forms - New GETPROPERTY parameter GRIDHASROWS has been added to return True/False if there
are valid rows in the Enhanced DB Grid control.
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62. 03/08/2019 Forms - New properties have been added to Enhanced DB Grid controls for progress bar column
types, allowing for a progress value to be hidden, the text displayed in different positions, and a color
for the progress text.

63. 03/08/2019 Forms - The LINEFEED character  (default: ^) is no longer displayed in Enhanced DB Grid data cells. A
blank space is used instead.

64. 03/12/2019 Forms - A new "Execute Node EEP On Tree View Click" property has been added to Tree View controls
to specify the "nodes" EEP is fired when the Tree View is clicked.

65. 03/13/2019 Forms - A PROPERTY APPLICATION parameter has been added to specify the Internet Explorer version
to emulate when displaying Web Browser controls in forms. 

    PROPERTY APPLICATION WEB_BROWSER_EMULATION 11000

66. 03/18/2019 Reports/Labels - The report writer has options for Duplex: None, Horizontal, Vertical.  But there is no
option that simply uses whatever setting the user has specified directly with the printer (Default). 
Users require two-sided printing through the printer setup and the reports still come out one-sided.
Could this an option be added to use the printer's duplex setting?

67. 03/20/2019 Database Explorer - Added "In Property Names" option for Control Property searches to locate text
for the actual property (e. g. ReadOnly, AutoSize, Show Hint, etc.) in use for objects in forms, reports,
and labels.

68. 03/25/2019 Plugins - The Dialog Builder Plugins were updated to include the "Show Accelerator Character"
option, which determines whether the text will display an ampersand (&) as opposed to underscoring
the next character.

69. 03/28/2019 Commands - A new GETPROPERTY command parameter was added  to capture the state of the
current row of a table. The possible return values are: ENTER, EDIT, BROWSE.

    GETPROPERTY TABLE 'TableName->STATE' VarName

70. 04/04/2019 Database Explorer - A new "Show Hidden Items" setting has been added which toggles the display of
files, based upon the "hidden" file attribute. Hidden files may include databases, external form files,
applications, and command files.

71. 04/15/2019 Database Explorer - When using the Find in Control Properties and sending the results to an output,
the matches for the text criteria is included in the output.

72. 04/22/2019 Commands/Forms - When using the CaptureFromVideoEx 'JPG 320' for form image controls, the
image is cropped as it is resized. Is there a way to have the PROPERTY shrink the image instead? Right
now I have to take the photo, then open the picture in the database, and resize it manually to reduce
it to a size, so that does not overload the table and/or variables when loaded.

73. 04/23/2019 Report Conversion - When converting DOS reports, the availability of font names, styles, and sizes
options, would be helpful to allow the converted fonts to fit accordingly.

74. 04/23/2019 Form Conversion - When converting DOS forms additional font size options, such as 8, 9, would be
helpful to allow the converted font size to fit accordingly.

75. 04/30/2019 Forms - Using a collapse panel to show a large amount of text within the control, the animation is
slower during expanding/collapsing, versus when image content is predominantly used.

76. 05/03/2019 Forms - The MAKECLICK property was added to the Office Button, Push Button, Bit Button, Speed
Button, Enhanced Speed Button, and Shape Button controls. The MAKECLICK property simulates a
mouse click on the button.
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77. 05/07/2019 Forms - The Tile Menu control has been updated with an additional "Single" option for the "Item
Check Mode", where one or zero tile items can be checked. This option unchecks the currently
checked tile item, when another tile item is checked. Other Item Check Modes include None and
Multiple.

78. 05/07/2019 Forms - After table structural changes have occurred, or when copying/duplicating forms associated
with a different table, it would be helpful to include an option to "replace a field" for DB Grid and
Enhanced DB Grid columns, where the substitute column retains all column-level custom settings.

79. 05/07/2019 Forms - When reviewing the DB Grid or Enhanced DB Grid columns after table structure changes have
occurred, or when copying/duplicating existing grid control forms associated with a different table, it
would be helpful to display an indicator for the invalid fields.

80. 05/08/2019 Forms/Commands - When using SET_FOCUS to change the input focus to a control, it can have
negative effects in some scenarios. SET_FOCUS steals the focus on a global level. That means, if a
control in a non active form gets a SET_FOCUS, the non active form becomes the active form and the
control is given the focus. This behavior does not blend well with popup forms (Pop-up Menu,
CHOOSE, etc.) that are shown during focus transition.

As such, SET_ACTIVE_CONTROL and DELAYED_SET_ACTIVE_CONTROL have been introduced to gain
focus in a more "respectful" way.

  PROPERTY ComponentID SET_ACTIVE_CONTROL TRUE
  or 
  PROPERTY ComponentID DELAYED_SET_ACTIVE_CONTROL TRUE

If SET_ACTIVE_CONTROL is used, the control will have focus if the parent form is the active form
(works like SET_FOCUS). However, if the parent form is not the active form, the control will get the
focus when the parent form becomes the active form. The "parent form recognition" is the difference
maker. The PROPERTY command use does not get in the way of other forms.

With DELAYED_SET_ACTIVE_CONTROL, the focus switch implemented uses PostMessage(), a safer
cross-origin communication between Windows objects, and allows the focus cycle to be completed
before a new focus switch cycle is started. The focus switch is basically "delayed."

Below explains each focus method:

 . SET_FOCUS - moves focus to the specified control. If parent form is not the active form, it will
become the active form as well.
 . SKIP - works like SET_FOCUS but uses the TabOrder to determine which control to focus to.
 . SET_ACTIVE_CONTROL - moves the focus to the specified control. If parent form is not the active
control, the focus switch will happen when the parent form becomes the active form.
 . DELAYED_SET_FOCUS - delayed SET_FOCUS
 . DELAYED_SET_ACTIVE_CONTROL - delayed SET_ACTIVE_CONTROL

Because it can be cumbersome to change SET_FOCUS into SET_ACTIVE_CONTROL or
DELAYED_SET_ACTIVE_CONTROL in many places, a newly added APPLICATION property was
implemented to treat SET_FOCUS commands as different "focus" counterpart.

    PROPERTY APPLICATION DELAYED_FOCUS_SWITCH ON|OFF

When ON, SET_FOCUS, SET_ACTIVE_CONTROL, and SKIP will work like
DELAYED_SET_ACTIVE_CONTROL. 

81. 05/09/2019 Reports - It would be helpful if the "Find Text in Print Preview" kept track of the search history.  The
search history is stored in the following: C:\Users\<User>\RBTI\RPTFINDPREV.RST

82. 05/09/2019 Forms/Commands - A new FILTEREDROWCOUNT parameter for the GETPROPERTY command has
been added to return the number of rows when an Enhanced DB Grid is filtered.

    GETPROPERTY InvGrid FILTEREDROWCOUNT vFilterRows
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83. 05/09/2019 Commands - A new PROPERTY command parameter was implemented to have all reports displayed in
the Print Preview to include the "Find Text" option, regardless of the report setting. 

    PROPERTY REPORT FIND_TEXT_IN_PREVIEW ON|OFF

84. 05/10/2019 Forms/Commands - A new PROPERTY parameter for Enhanced DB Grids has been implemented to
clear a filter applied to a grid.

    PROPERTY Invoices CLEARFILTER 'TRUE'

85. 05/10/2019 Forms/Commands - A new GETPROPERTY parameter for Enhanced DB Grid controls return TRUE or
FALSE for whether the grid has a filter applied. 

    GETPROPERTY EDBGrid1 HASFILTER vHasFilter

86. 05/10/2019 Forms - An option was added to turn on/off the display of accelerator characters in captions for the 
Split View control.

87. 05/13/2019 Report Designer - A "Run (Live)" option has been added to save and run the report from the designer
using live table data.

88. 05/17/2019 Forms - The Collapse Panel control always expands down, from a position located higher up upon a
form. Is it possible to have a "direction" property for the collapse panel to expand up?

89. 05/20/2019 R:BASE Editor - When right clicking in the Structure Toolbar in the editor, the menu to show/hide  all
tool bars is displayed. It would be more helpful to display options specific to the toolbar, such as:
refresh, the various output options with each having their own menu, if a command is highlighted:
jump to the command, Settings to open the Structure Toolbar tab in the settings, etc.
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Reported Bug Fixes 10/20/2018 - 05/23/2019

Date FixedItem Description

01. 10/24/2018 R:BASE Editor - R:Style, the programmer's friend, is not recognizing the NO_FOCUS option in PAUSE
commands, and is adding the keyword to the RStyle.new file.

02. 10/29/2018 Commands - When using #WHERE to define a predefined WHERE Clause for the CHOOSE command,
the quotes are stripped from the specified criteria.

03. 10/30/2018 Help Files - The PAUSE command syntax diagram does not include the BUTTON option.

04. 11/15/2018 Commands - When generating a CHOOSE list of options from a variable string containing consecutive
commas, the list is populated incorrectly.

05. 11/15/2018 Functions - When a list of items are evaluated by the LISTOF function, where some text items contain
embedded commas, the returned value is incorrect.

06. 11/20/2018 Commands - Using PAUSE, DIALOG, and CHOOSE commands with the extended "Web Colors", being
used from the Data Dictionary, the values are not displayed.

07. 11/20/2018 Data Dictionary - The values within "Color" and "Name" columns are off by a two colors after WHITE.
At first it is just two colors, then near WEBRED it is off by three, and somewhere down list it is off
more so.

08. 11/21/2018 Database Explorer - An attempt to insert an apostrophe into an existing comment displayed in the
Database Explorer with the "Change Comment" option returns an error. It is possible to include an
apostrophe within a table comment within the New Table design wizard.

09. 11/29/2018 Database Explorer - When the "Change Current Folder" button on the property bar is launched and
selects a folder which contains an ampersand, the accelerator character is displayed in the status bar
caption.

10. 11/29/2018 Forms - When selecting to right click and delete a Lookup List View control the object is not deleted.

11. 11/29/2018 Database Explorer - When R:BASE is launched in a folder which contains an ampersand, the
accelerator character is displayed in the property bar of the Database Explorer.

12. 12/13/2018 Commands/Settings - When issuing a CONNECT upon a database that is already connected with
RBADMIN set ON, the R:BASE instance closes unexpectedly.

13. 12/13/2018 Forms - When a lookup combo box object is located within grids and scrolling regions, a parenting
issue is encountered.

14. 12/13/2018 File Gateway - When using the GATEWAY EXPORT "Fixed" format to export data, any CURRENCY
columns will offset the fixed positioning.

15. 12/26/2018 Forms - When opening the dialog to add fields for a multi column pop-up menu, the column list is
blank.

16. 12/27/2018 Reports/Labels - When an Angle is set to a label, without Autosize enabled, errors are encountered
after the reports/label is saved and opened again in the designer.
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17. 01/03/2019 Form Wizard - When creating a form in the wizard, and enabling the "Use Field Comment as Caption"
check box, the first column displayed in the wizard does not receive the correct caption.

18. 01/03/2019 Data Types - When retrieving a row's data consisting of the WIDETEXT data type, the information is
padded with spaces.

19. 01/03/2019 R> Prompt - When first launching the R>Prompt where a list of commands is displayed in the
Command History, the first command in the history is not immediately available with Page Up/Page
Down.

20. 01/04/2019 Commands/Forms - The PROPERTY command to update/reset the Form > Table settings has been
enhanced in instances where the main table name is not set properly in the form's data. The
command is as follows:

    PROPERTY APPLICATION RESET_FORMS_ROW_UPDATE_FLAG '*'

21. 01/09/2019 Reports - When using the Report Wizard and creating a new report, the created Page Header and
Detail fields are not using a height which allows for the text to be seen completely.

22. 01/10/2019 Forms - When opening the DB Edit properties, the "Table" and "Columns Returned" fields are blank
where values were previously set.

23. 01/14/2019 External Forms - In some instances of launching external forms with MDI, a non-modal form may get
hidden, when the modal form that shows the non-modal form is closed, after the non-modal form is
shown.

24. 01/21/2019 Data Browser - When running the Data Browser, the response time seems much slower than expected.

25. 01/22/2019 Settings - With RBADMIN set to ON and while opening dual instances of R:BASE on the same
workstation, a subsequent connection closes the other R:BASE instance abruptly.

26. 01/28/2019 Commands - In the documentation, variable names have the restriction that the name must begin
with a letter, contains only letters, numbers, and some special characters. However, the SET VARIABLE
command allows the creation of variables whose name begins with non-letter values.

27. 01/28/2019 Commands - When using the title portion, the command SELECT ... HTML generates partial HTML
content before detecting a syntax error.

28. 01/29/2019 Watch Variables - In the Watch Variable List, if the mouse cursor hovers over a long text Value that
has been truncated (terminates with "..."), the pop-up tip intended to display the full non-truncated
value is partially obscured by the Watch Variable List window itself.

29. 01/29/2019 Favorite Commands - Commands that are newly added to the R> Favorite Commands Panel from the
Command History Panel (either by clicking the Add to Favorite Commands icon or by clicking that
selection in the right-click menu) do not appear there until R:BASE is restarted.

30. 01/29/2019 Commands/Settings - When ECHO and FEEDBACK are set ON, the very first use of a SELECT or
PROJECT command spools the RBTI "feedback" variables to the R> Prompt output console. The SET
VAR group does not recur until R:BASE is restarted.

31. 01/29/2019 R> Prompt - When the mouse cursor is positioned within the R> Output Console, pressing Ctrl+F
brings up the Find in R> Prompt Output window as expected, but it repositions the cursor to the
Input Console instead of to the Search Text input field. (This problem does not occur if the mouse
cursor is initially positioned within the Input Console.)

32. 01/29/2019 Settings - When ECHO and WINBEEP are set to ON, any error, or for the BEEP command itself, a
RBTI_WINBEEP variable is displayed in the output console.
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33. 01/29/2019 Favorite Commands - The double-headed arrow that appears when hovering the mouse cursor over
any border (including corners) of the Favorite Commands panel suggests that the panel can be
arbitrarily resized like any other window, but when attempting to resize below some threshold,
continuing to drag the border no longer performs a "resize" but rather a "move" operation (if
dragging left or top border), or is ignored (if dragging right or bottom border).

34. 01/29/2019 Data Dictionary - When selecting Copy Value from the right-click menu does not always place an
exact copy into the Windows clipboard. In particular, when the value copied from a text variable
contains quotes, the resulting clipboard version is bracketed by additional enclosing quotes and any
original quotes are doubled. While this behavior is useful in certain contexts (e.g., pasting into Excel),
in other cases the original text must be preserved without any modification.

35. 01/30/2019 Commands - The GETPROPERTY APPLICATION MONITOR_PROPERTY[X] command does not
immediately report an error when an invalid number is supplied for the value in brackets (even with
CHECKPROP ON). Instead, it inserts the text "-ERROR- Invalid index" in place of the normal
comma-separated list of monitor attributes.

36. 01/31/2019 Reports/Labels - The Self Adjusted Font attribute does not appear to have any effect. In my tests with
a DB Memo control, long text was truncated, not resized within the control.

37. 01/31/2019 Help Menu - When ECHO is set ON, clicking Help > About R:BASE spools the text "HELP ABOUT" to
the Output Console.

38. 02/01/2019 Database Explorer - When ECHO is set ON, double-clicking a table name from within Database
Explorer spools the text " BRO ALL FROM <tablename> MDI" to the Output Console. Alternatively,
depending on the Database Explorer Settings Double Click Open Designer and Use Dialog to Open
Table/View, it may spool the text "RBDEFINE <tablename>".

39. 02/01/2019 Settings - When ECHO is set ON, making a change to Configuration Settings spools dozens of SET
commands to the Output Console.

40. 02/04/2019 Settings - With TRANSACT set ON and AUTOCOMM set ON, an attempt to modify a table field within
the Data Browser produces a sequence of error messages.

41. 02/04/2019 Commands - In the DIALOG command, the MESSAGE_BACK_COLOR option has no apparent effect. It
is listed in the help, and it included when the DIALOG Builder Plugins are used, but altering the value
does not alter the dialog.

42. 02/04/2019 Commands - When a SELECT command includes an INTO clause and FEEDBACK is set ON, Feedback
always reports 0 rows selected. This has resulted in confusion, since the message suggests the
command has failed, when, in fact, it has succeeded.

43. 02/05/2019 Form Designer - In a Variable Lookup List View control, the Focus Color (set in the Colors tab of the
Properties window) has no apparent effect.

44. 02/05/2019 Form Designer - Selecting Document Custom EEPs to a text or PDF file or to the Text Editor while
ECHO is set ON intersperses a WRITE command between each line of output. This does not occur
when spooling to the clipboard.

45. 02/05/2019 Form Designer - The Object Inspector lists the "readonly" property last, out of alphabetical order
(perhaps because it begins with a lower-case letter). This only occurs for certain control types: DB Edit,
DB Memo, Variable Edit, Variable Memo, and perhaps others.

46. 02/05/2019 Form Designer - When "Show Read-Only Status" is checked for the Tab Order Dialog within the
Default Form Settings, the window lists nearly every control as having the ReadOnly property.

47. 02/05/2019 Form/Report Designers - The "Horizontal > Center in Window" and the "Vertical > Space Equally"
icons for the Align Palette are in each other's spot.
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48. 02/05/2019 Form Designer - If the Object Inspector is used to change certain control properties (e.g., Height, Left,
Top), the positions of the 8 bounding blue dots or handlebars do not update their proper location on
the control until the control is re-selected. (In contrast, when these properties are modified using the
right-click Properties panel, the position-update is sometimes immediate, and sometimes ineffective,
at least when applied to a Static Text control.)

49. 02/05/2019 Form Designer - When moving form controls to different locations and then using the Undo feature,
with many undo operations after another, R:BASE becomes unresponsive.

50. 02/06/2019 Form Designer - When selecting to Document Custom EEPs and send the output to the R:BASE Editor,
the "On Row Entry" Custom EEP for the table consists of duplicate code that does not match what is
used in the EEP.

51. 02/06/2019 Forms - It looks like the "Hide Selection" setting in Variable/DB Lookup List View controls have no
effect visually. The selection is always visible.

52. 02/06/2019 R:BASE Editor - R:Style flags the command @SET ECHO OFF as invalid.

53. 02/06/2019 R:BASE Editor - R:Style does not capitalize all expected keywords. For example, in property compid1
radiobuttons[n]->checked 'value', it leaves "radiobuttons" in lower case.

54. 02/06/2019 Form Designer - In the list of properties within Variable Links, "readonly" is the only item where the
case is not applied like others.

55. 02/07/2019 Report Designer - The Object Inspector lists the "left", "name", and "top" property items last in the list,
out of alphabetical order.

56. 02/07/2019 Report Designer - After a new label is added to a report, and Undo is then selected to step back the
new addition, there are actually many Undo steps required for the background, font, and object
placement to occur before the new object is finally removed from the report.

57. 02/15/2019 Form Designer - When displaying the Variable Links Overview in the designer, the icon images for the
new X.5-specific controls do not appear in the list.

58. 02/18/2019 Commands - Using LAG and LEAD works as expected on table InoviceHeader, but not on the view
SalesByEmployee. The PARTITION BY has no effect.

59. 03/04/2019 Data Designer - When using the "Insert Column" menu option, where the new value matches a
column that already exists in another table, the type is taken from the existing column, but the
expected description is not set.

60. 03/04/2019 Form Designer - When searching for text with Find in Form Control Properties, the caption for
Collapse Panel controls do not appear in the results.

61. 03/08/2019 Forms - If a default format is not specified in the control properties, a Date/Time Picker will use the
current R:BASE sessionâ€™s date/time format.

62. 03/08/2019 Forms - The "On Click" EEP will not be triggered if a DB/Variable Lookup Combo Box's WHERE Clause
is empty.

63. 03/13/2019 Commands - When repeatedly using the BROWSE DISTINCT command with a UNION that combines a
text string to the query, at some point the Data Browser will not appear and errors are displayed.

64. 04/02/2019 Forms - In some instances the File List Box control restores the current folder prior to showing the
form if the "Restore Directory" property is checked.

65. 04/03/2019 Forms - We are required to have 20 character passwords. When I add the design password on our
external form files to 20 characters and save it, it will not open again with that password.
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66. 04/15/2019 Database Explorer - When using the "Output" button for the Find in Control Properties results, the
first line in the output reads "Find in EEPs Results"' not "Find in Control Properties Results."

67. 04/22/2019 User Privileges - When I go into User Privileges, I delete a user and when I refresh or exit and go back
in, the user is still there.

68. 04/22/2019 File Gateway - When performing an import/export with the File Gateway utility, where the progress
dialog is displayed, it appears the import/export process is frozen if the user clicks on the File Gateway
window, as the progress dialog is moved behind the File Gateway window. It would prevent confusion
if the progress dialog was not placed behind the File Gateway window, if the Gateway GUI is clicked.

69. 04/22/2019 Commands - When using the CONVERT command upon a RB1-RB4 database, the utility deletes the
database files.

70. 04/23/2019 Form Conversion - When converting DOS forms, with pop-up menu options for edit fields where the
Use Dynamic Where Clause message text is mixed with the WHERE Clause, syntax error messages are
encountered when executing (double-clicking) all pop-ups.

71. 04/23/2019 ODBC - When attempting to ODBC SATTACH from a R:BASE database that has STATICDB set to ON,
to another R:BASE database, a "The database is currently unavailable -- it is open with STATICDB set
ON." warning is displayed.

72. 04/24/2019 File Gateway - Using the Import Wizard, the fixed format stops at column 1060 when attempting to
define the column definitions. The file is actually larger, where the rest had to be completed manually.

73. 04/25/2019 File Gateway - When using the File Gateway utility, or command syntax, a large fixed format file does
not load into a table.

74. 04/29/2019 User Privileges - I have implemented user permissions. It was working but when a lot of users connect
it comes to a very slow process.

75. 04/30/2019 Forms - In the Collapse Panel property editor, under the Settings tab, the Vertical Alignment radio
buttons does not have a button option in use. After selecting a value and returning to the tab, the
setting is not saved.

76. 05/03/2019 Expression Builder - When specifying a custom Memo Font for the Expression Builder, the font is not
carried over to the other Expression Builders in the other designers.

77. 05/03/2019 Utilities - When launching the R:BASE On-Screen Keyboard using the PROPERTY command, the
caption does not display the caption value within the ROSK Settings.

78. 05/06/2019 Commands - When using string concatenation with an ampersand for TEXT and VARCHAR variables,
and error is encountered. The plus character string concatenation does work.

79. 05/06/2019 Functions - The SLOCP function returns an incorrect result when using the -1 value for argument3 (to
return the last occurrence of a string), where the searched criteria is also the last instance in the string.

80. 05/06/2019 Database Conversion - When performing a database conversion with the CONVERT command and an
invalid comment is encountered, the conversion process is halted with no warning or message.

81. 05/06/2019 Utilities - If the ROSK Settings is not launched at least once, and the visibility of a key is changed using
the PROPERTY ROSK command, then the disabled keys for the R:BASE On-Screen Keyboard may be
drawn incorrectly.

82. 05/10/2019 Forms - When applying a filter on numeric fields for an Enhanced DB Grid, the results are incorrect.

83. 05/10/2019 Data Designer - When inserting an existing common column into a table the calculation is not carried
over as expected.
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84. 05/14/2019 Forms - When a form uses a large number of command file/EEP nesting with SET_FOCUS (or SKIP)
switching the focus from field to field, processing becomes unstable. The behavior is more relevant to
Windows 10 operating systems.
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